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About This Book and the Library

The Reporting Guide provides conceptual information about the NetIQ Reporting Center (Reporting 
Center) product. This book defines terminology and various related concepts.

Intended Audience
This book provides information for individuals responsible for understanding Reporting Center 
concepts.

Other Information in the Library
The library provides the following information resources:

Help 

Provides context-sensitive information and step-by-step guidance for common tasks as well as 
definitions for the fields on each window.

Release Notes 

Provides information about enhancements to Reporting Center since the last release, and lists 
any known issues for this release.
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Conventions
The library uses consistent conventions to help you identify items throughout the documentation. The 
following table summarizes these conventions.

Convention Use

Bold • Window and menu items
• Technical terms, when introduced

Italics • Book and CD-ROM titles
• Variable names and values
• Emphasized words

Fixed Font • File and folder names
• Commands and code examples
• Text you must type
• Text (output) displayed in the command-line interface

Brackets, such as [value] • Optional parameters of a command

Braces, such as {value} • Required parameters of a command

Logical OR, such as 
value1|value2

• Exclusive parameters. Choose one parameter.
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About NetIQ Corporation

NetIQ, an Attachmate business, is a global leader in systems and security management. With more than 
12,000 customers in over 60 countries, NetIQ solutions maximize technology investments and enable IT 
process improvements to achieve measureable cost savings. The company’s portfolio includes award-
winning management products for IT Process Automation, Systems Management, Security Management, 
Configuration Audit and Control, Enterprise Administration, and Unified Communications 
Management. For more information, please visit www.netiq.com.

Contacting Sales Support
For questions about products, pricing, and capabilities, please contact your local partner. If you cannot 
contact your partner, please contact our Sales Support team.

Contacting Technical Support
For specific product issues, please contact our Technical Support team.

Contacting Documentation Support
Our goal is to provide documentation that meets your needs. If you have suggestions for improvements, 
please email Documentation-Feedback@netiq.com. We value your input and look forward to hearing 
from you.

Contacting the Online User Community
Qmunity, the NetIQ online community, is a collaborative network connecting you to your peers and 
NetIQ experts. By providing more immediate information, useful links to helpful resources, and access to 
NetIQ experts, Qmunity helps ensure you are mastering the knowledge you need to realize the full 
potential of IT investments upon which you rely. For more information, please 
visit http://community.netiq.com. 

Worldwide: www.netiq.com/about_netiq/officelocations.asp

United States and Canada: 888-323-6768 

Email: info@netiq.com

Web Site: www.netiq.com

Worldwide: www.netiq.com/Support/contactinfo.asp

North and South America: 1-713-418-5555 

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netiq.com

Web Site: www.netiq.com/support
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Chapter 1
Understanding Reporting Center

NetIQ Reporting Center (Reporting Center) allows you to extract data from the databases of NetIQ 
products and present the information as charts or tables in reports. Reporting Center transforms the data 
into useful information about the computing infrastructure that supports your business. You can use 
these reports to track the performance of your servers, uncover trends across your network, make 
forecasts, and track security events. Reporting Center uses Microsoft SQL Server and SQL Server 
Reporting Services (SSRS) to deliver up-to-the-minute enterprise analysis reports.

Reporting Center Architecture
Reporting Center is made up of a number of software components that you can install on one computer 
or distribute across multiple computers. The Console, Web Service, and Reporting Services Data 
Extension work together with a Configuration Database to retrieve data and execute usable reports in 
Reporting Center. You can then deploy the reports to SSRS. You can view executed reports in the 
Reporting Center Console or in a browser.

The following diagram provides an overview of the Reporting Center architecture.
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Console
The Console is the Reporting Center user interface, where you execute reports and do administrative 
tasks, such as defining Reporting Center accounts, groups, and permissions. From the Console you can 
manage connections to databases on any SQL Server. You can also configure contexts for each report, 
such as setting a time frame, selecting data streams, and specifying parent categories of data. You can 
customize the look and feel of a report by modifying its properties in Reporting Center, and then deploy 
it to SSRS.

Configuration Database
The Configuration Database contains information that Reporting Center uses to execute your reports, 
including settings you configure during installation, as well as information that you define and view in 
the Console. The Configuration Database includes the following information:

• Security information, such as the level of privileges assigned to each user, and the permissions you 
define for folders and reports.

• SQL server and database names that Reporting Center uses to execute reports.

• Information about folders you set up in the Console, which group your reports and database 
connections.

• Web Service specifications.

• Customized schedule configurations and the status of scheduled reports.

Web Service
The Web Service is the centralized point of access to all your databases. It serves as the layer between the 
Console and the source databases, running the SQL queries that gather report data and then returning 
the data to the Console. In addition to authenticating source database connections, it also authenticates 
connections to the Reporting Services Data Extension, which, in turn, publishes your reports to SSRS. 
The Web Service runs on a Microsoft Internet Information Services (IIS) Web server.

Reporting Services Data Extension
Reporting Center allows you to deploy reports to SSRS, which is the component of SQL Server that 
allows you to create, manage, and deliver reports on a schedule. When you deploy a report from 
Reporting Center, the Reporting Services Data Extension communicates with SSRS through the Web 
Service to deliver the information. SSRS publishes the report, which you view in a Web interface.
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Chapter 2
Installing Reporting Center

This chapter lists the system requirements, account requirements, and supported applications for 
Reporting Center components. It also provides information about things to consider when you plan your 
installation or upgrade, and how to get started using Reporting Center.

System Requirements
The following table lists the hardware and software requirements for Reporting Center components.

Requirement
Disk Space 575 MB free disk space

Memory 512 MB, 1 GB recommended

Screen Resolution At least 1024x768 for the Console

Operating System One of the following operating systems:
• Microsoft Windows Server 2003 (32-bit or 64-bit)
• Microsoft Windows Server 2003 R2 (32-bit or 64-bit)
• Microsoft Windows Server 2008 (32-bit or 64-bit)
• Microsoft Windows Server 2008 R2 (64-bit)

The Console also supports the following desktop operating systems:
• Microsoft Windows 7
• Microsoft Vista Enterprise
• Microsoft Windows XP Professional

Configuration Database Microsoft SQL Server 2005, 2008, or 2008 R2 
(Express, Standard, or Enterprise Editions on 32-bit or 64-bit systems)
Ensure that you install SQL Server and the Windows operating system on the 
same platform, either 32-bit or 64-bit.

Console Microsoft .NET Framework 3.5 SP1

Web Service • Microsoft Internet Information Services 6.0, 7.0, or 7.5
• Microsoft .NET Framework 2.0

Data Extension • Microsoft SQL Server Reporting Services 2005, 2008, or 2008 R2 
(Standard or Enterprise Edition, not Express Edition)

• Microsoft .NET Framework 2.0
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Planning Your Installation
This section includes the following information to help you plan your installation:

• Descriptions of the user accounts you will need to create or identify before installation.

• Installation prerequisites for each component of Reporting Center.

• Installation considerations for each component and the Windows Server 2008 and 2008 R2 
operating systems.

Account Requirements
The following table lists the accounts you need to create or identify before installing Reporting Center.

Installation Prerequisites
The following table lists the prerequisites you need to install each component of Reporting Center. For 
more information about specific accounts, see the Account Requirements table.

Account Description Requirement
Database Installer 
Account

Account you log in with to run 
the Setup program that creates 
the Configuration Database.

• System Administrator privileges on the 
SQL server where you install the 
Configuration Database.

• Local administrative permissions on the 
computer where you run the Setup 
program.

Web Service Installer 
Account

Account you log in with to run 
the Setup program that creates 
the Web Service and also 
configures the Web Service 
account in the Configuration 
Database.

• System Administrator privileges on the 
SQL server where you install the Web 
Service.

• Local administrative permissions on the 
computer where you run the Setup 
program.

Web Service User 
Account

Account that the Web Service 
uses to retrieve data from the 
reporting database.

• db_owner role on the Configuration 
Database.

• db_datareader role in each reporting 
database.

Console Account Account that connects to the 
Web Service to display and use 
the Console.

• Ability to log into the Web Service.

Component Installation Prerequisites
Configuration Database • Credentials for the Database Installer Account.

• The name of the SQL Server instance where you will install the 
Configuration Database, in this format: ServerName\Instance

Web Service • Credentials for the Web Service Installer Account.
• The location of the Configuration Database, in this format: 
ServerName\Instance

• Credentials for the Web Service User Account.
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The Order of Your Installation
You can install the Reporting Center components individually or in any combination. If you install the 
components on separate computers, install the components in the following order:

1. Configuration Database

2. Web Service

3. Reporting Services Data Extension

4. Console

Configuration Database Considerations
Before you install the Configuration Database, consider the following information:

• After installing Reporting Center, if you run the Setup program to modify your installation, there is 
no option to install the Configuration Database. This is a safeguard that prevents you from having 
multiple Configuration Databases installed in a single Reporting Center environment.

• After installing Reporting Center, set up regular SQL server backups for the Configuration Database.

• When you uninstall Reporting Center, the setup program removes all components except the 
Configuration Database.

Web Service Considerations
If you install the Web Service on a non-default Web site, do not customize the corresponding Host 
Header value. For information about removing the Host Header, see the Troubleshooting chapter.

Reporting Services Data Extension Considerations
Before you install the Reporting Services Data Extension, consider the following information:

• You usually install the Reporting Services Data Extension on the computer hosting SSRS, your report 
server. However, if you are planning on using the Report Designer component of SSRS to customize 
reports, install the Reporting Services Data Extension on the computer hosting Report Designer.

• If you configured SSRS with SSL, during installation you can specify the URL for the SSL-configured 
report server. You can also change the default SSRS URL after installation in the Console. Go to 
Tools > Options > Enterprise Options > Reporting Services > Default Report Server Location, and 
enter the URL for the SSL-configured report server.

Console • The location of the Configuration Database, in this format: 
ServerName\Instance

• The name of the Web Service server, in this format: http://
ServerName/ACWebService

Reporting Services Data 
Extension

• The location of SQL Server Reporting Services (SSRS), in this format: 
ServerName\Instance

Component Installation Prerequisites
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Console Considerations
Because the Web Service is the communication layer between the Console and the database, install the 
Web Service before installing the Console.

Installing Reporting Center on Windows Server 2008 and R2
Install IIS on Windows Server 2008 (IIS 7.0) or Windows Server 2008 R2 (IIS 7.5) with the following 
Role Services selected:

• Application Development: ASP.NET

• Security: Windows Authentication

Getting Started with Reporting Center
Once you have installed the Reporting Center components, you can open the Console and begin 
managing database connections, setting security permissions, and executing reports. This section 
describes how to start Reporting Center and begin working with database connections.

Starting Reporting Center
When you log on to the Console, the Web Service uses IIS to validate the account credentials according 
to the way you configured the Web Service during installation.

To start Reporting Center:

1. Log on to the computer where you installed the Reporting Center Console.

2. Click Start > Programs > NetIQ > Reporting Center > Reporting Center Console.

3. Provide the required information in the Logon dialog box and click Logon.

Navigating Reporting Center
Reporting Center is made up of three easily navigable areas from which you can perform all the tasks 
relating to database connections, security settings, and reports.
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Navigation Pane
The Navigation pane is the starting point for Reporting Center. Use the Navigation pane to initiate tasks 
such as choosing a database connection and selecting a report. The information in the other panes 
change according what you do in the Navigation pane.

The Navigation pane contains Reporting Center Home, which allows you to start managing security, 
database connections, and reports. When you click Reporting Center Home from the Navigation Pane 
or the toolbar, Reporting Center displays links to start each of those tasks, along with information about 
your current security settings, database connections, and reports.

Results Pane
The center of the Reporting Center interface contains the Results pane, which displays any information 
related to the folder, report, or database connection you select in the Navigation pane. This includes, for 
example, the contents of a report or the details of a database connection. When you modify report 
properties Reporting Center and then execute a report, the Results pane displays the report with those 
changes.

Tasks Pane
The contents of the Tasks pane change depending on what you select in the Navigation pane. When you 
select an individual report, for example, the Tasks pane displays three tabs: Context. Tasks, and 
Properties. They contain the context controls for the report, a list of report-related tasks, and the property 
controls for the report.

Managing Database Connections
Database connections are the basis for the reports that you execute with Reporting Center. The Setup 
program automatically configures your initial database connections according to the information you 
provide during installation. These database connections point to specific database servers that provide 
the data for your reports. Database connections use either Windows authentication or SQL 
authentication, depending on the security configuration of the source SQL Server and the choices you 
make when installing SQL Server. After installation, you can configure additional database connections 
and modify connection properties in the Console. When you add or modify a connection, you need to 
restart the Reporting Center Application Pool.

Restarting the Application Pool
If you make any changes to database connections, such as modifying the authentication method, or 
adding or deleting connections, restart the Reporting Center Application Pool in Microsoft IIS Manager.

To restart the Application Pool:

1. In IIS Manager, expand the Console server, and expand Application Pools.

2.  Right--click NRCAppPool and select Stop.

3.  Right--click NRCAppPool and select Start.
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Chapter 3
Configuring Reporting Center Security

Once you have installed Reporting Center and become familiar with the interface and database 
connections, the next step is to implement security. Reporting Center security defines what is visible to 
each user, and determines what each user is allowed to do in Reporting Center.

Understanding Reporting Center Security
Configuring security in Reporting Center means restricting or allowing users access to report folders and 
database connections. To configure security, define accounts, groups, and permissions.

Accounts

Individual users. Administrators create an account for every user.

Groups

Collections of accounts. Every account must be a member of at least one group.

Permissions

Definitions specifying the level of access to database connections, folders, and reports that groups 
can have.

Planning and configuring security includes the following types of tasks:

• Enabling or disabling accounts, granting Reporting Center Administrative permissions to individual 
accounts, and adding Windows accounts to Reporting Center.

• Creating groups of Reporting Center accounts, granting administrative permissions to specific 
groups, and adding Windows accounts to Reporting Center groups.

• Creating permissions that are more restrictive than administrative permissions, and then enabling or 
disabling those permissions.

• Organizing your security model before you implement it by creating accounts, groups, and 
permissions, and keeping them disabled until you are ready to apply security. You can also enable or 
disable specific accounts, groups, or permissions during the ongoing administration of Reporting 
Center security.
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Working with Accounts and Groups
Because you configure Reporting Center security by assigning a group and a permission to each object in 
the Navigation pane, the primary purpose of creating an account is to assign it to a group. You can grant 
accounts administrative privileges, but you cannot associate permissions with accounts by themselves.

You can create accounts, groups, and permissions in any order. Once you have created accounts, groups, 
and permissions, you can add accounts to groups, and assign a group and a permission to a folder, report, 
or database connection.

For example, you might want to allow broad access to various report folders, but restrict access to database 
connections so that only an administrative group with permissions to create database connections can 
work with them.

Using Windows Accounts and Groups in Reporting Center
In addition to allowing you to create new accounts, Reporting Center uses existing Windows accounts 
and adds them to Reporting Center accounts and groups. Each time a user logs on to the Web Service to 
access the Console, Reporting Center checks both the local Windows groups on the Web Service 
computer and the groups defined in Reporting Center. When the group names match, Reporting Center 
adds the Windows account to the corresponding Reporting Center group.

Reporting Center has three pre-defined groups:

BUILTIN\Administrators

Grants members of the Windows Administrator group full, administrative permissions in 
Reporting Center.

BUILTIN\Users

Grants members of the Windows Users group limited, non-administrative permissions in 
Reporting Center.

Reporting Center Everyone

Includes all Reporting Center accounts automatically, and allows administrators to grant 
permissions globally to anyone who logs on to the Console.

For example, if the connecting user is a member of the Windows group Administrators, then that user is 
added as a Reporting Center user with administrative permissions, and is added to the pre-defined 
Reporting Center group BUILTIN\Administrators. If the connecting user is a member of the Windows 
group Users, then that user is added as a non-administrative Reporting Center user, and is added to the 
pre-defined Reporting Center group BUILTIN\Users.

The account you use to install Reporting Center is added as an administrative account with full 
permissions. The automatic addition of Windows users to Reporting Center groups works for the two 
default groups. If you want to create additional local Windows groups and matching Reporting Center 
groups to take advantage of the automatic addition of users, use the following naming convention for the 
Reporting Center groups: 
<Web Service computer name>\<Windows group name>

If you remove a member from a Windows group on the Web Service computer, you can no longer use 
that account in Reporting Center, but the account remains in Reporting Center until you remove it.
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Working with Permissions
Reporting Center provides you with a number of ways to restrict or grant access to database connections, 
folders, and reports. You can assign administrative rights to an account or a group, which gives them full 
Reporting Center permissions to view and manipulate anything in the Navigation pane. Defining 
permissions allows you to enforce more granular security for each object in Reporting Center.

You can allow or restrict access to every task users can do, so that, for example, one group can have 
permission to create and delete reports, and another group can have permission to only view reports. You 
will decide what users can do according to what they need to effectively do their jobs, and according to 
how you want to configure your entire system.

When you configure permissions, Reporting Center represents the status of specific permissions in 
checkboxes. Permissions have three states.

Reporting Center has a number of predefined permissions that you can either customize to create new 
permissions, or use as provided. These permissions allow various levels of access to folders, nodes and 
reports in the Navigation tree. The following table lists the predefined permissions, along with the access 
they allow or restrict. If you customize one of these permissions, you can allow or restrict access to each 
individual task, such as creating folders, exporting reports, and so on.

Allowed: Users will have access to the object with this permission or will be allowed to 
do the specified task (such as modifying reports or creating folders).

Denied: Users will not be able to access the object with this permission or will not be 
allowed to do the specified task. When a user logs on, Reporting Center does not 
display the restricted objects.

Undefined: The specified task does not have any defined permissions. Users will be 
able to view these objects but not complete the tasks.

Category Permission
Administration Full Permissions allows administrators to assign security rules to the 

folder or database connection.

Folder One of the following permissions:
• Full Permissions allows you to create, delete, move or rename the 

folder.
• No Permissions allows you to only view the folder.

Node No Visibility restricts viewing access to the node (database connection, 
folder, or report).

Report One of the following permissions:
• Execute Only restricts access to everything except executing the 

report.
• Execute allows groups to execute the report only, but does not restrict 

access to the other tasks. Their states are undefined.
• Full Permissions allows groups access to the full range of report 

tasks: delete, deploy, execute, export, move, print, rename, save, and 
save as.

• Modify and Use allows groups to execute, export, print, and save the 
report.
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Configuring Security Settings
Use the Manage Security dialog box to create, modify, or delete user accounts, groups, and permissions. 
You can easily modify your security model so that users can view and execute only the reports and 
database connections relevant to them. Reporting Center saves all security settings in the Configuration 
Database.

To configure security settings:

1. Click File > Manage Security or click Manage Security on the toolbar.

2. Click either Accounts, Groups, or Permissions.

3. If you are creating a new account or group, click Add.

4. If you are creating a new permission, do one of the following tasks:

- Click Add.

- Select a predefined permission and click Add.

5. If you are modifying, copying, or removing a setting, select the specific account, group, or 
permission and click Add, Modify, Copy, or Remove, according to what you want to do.

For information about specific fields, click Help in the dialog box.

Assigning Security
Once you have set up accounts, groups, and permissions, the next step is to apply security to the objects in 
the Navigation pane. When you configure security for these objects, you choose a group and a permission 
set and associate them with the specified object. These security settings determine what users are allowed 
to do in Reporting Center. You can apply security to every object except Reporting Center Home, which 
is the root object in the Navigation pane.

For objects in a hierarchy, Reporting Center uses the most restrictive permissions and applies them to the 
subfolders and objects. If you have not configured security for a particular object, that object inherits the 
permissions of its immediate parent. When you log on to Reporting Center, it displays only the objects 
that you have permission to view.

For example, suppose a group has permission to view the default Reports folder, as well the folder for 
Application A, but does not have permission to view the folder for Application B. In this case, the group 
has access to the reports for Application A, but does not have access to the reports for Application B. The 
Console will not display the Application B folder when users from that group log on.
12 Reporting Guide



Applying Security to an Object
You can add multiple accounts to a group. You can also add the same group multiple times with different 
permissions. In this case, if there are overlapping permissions (for example, two different sets that both set 
permissions for reports), the most restrictive permission set takes precedence.

Note that permissions for databases are embedded in the Administration permission set.

To apply security to a folder, database, or report:

1. Right-click the object in the Navigation pane and click Security.

2. Click Add.

3. In the dialog box, choose a group and then choose a permission set. Reporting Center enforces this 
permission set for the group you select.

4. Click Add and then click OK.
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Chapter 4
Working with Reporting Center Reports

This chapter describes Reporting Center reports and provides information about configuring reports to 
display data in a particular way. For example, you can choose a date range for each report, the way a chart 
looks in the report, and the number of rows Reporting Center retrieves from the database for a particular 
report. It also describes how to execute reports in Reporting Center, and how to deploy reports to SQL 
Server Reporting Services (SSRS).

Understanding Reports
Reports contain information that Reporting Center retrieves from databases specified in the reports and 
displays the information in the following ways:

• In a chart, a graphical representation of the data.

• In a table, containing rows and columns of data.

• In both a chart and table.

When you select a report, Reporting Center displays the contents of the report in the Results pane, and 
the contexts and properties of the report in the Tasks pane.

Contexts

The data controls defined in the report, such as the database connection, data streams, and time 
frame. The information in the Context tab changes according to the definitions of the report. If 
the report has no defined contexts, the Context tab is blank, and Reporting Center displays a 
link to the Configuration Card, which contains the settings for that report. You can modify most 
contexts to customize your report. You can also filter nodes on the context tree to display specific 
data, and you can perform a search on the context tree. Note that these functions are exclusive: 
entering text in the Search box disables the Show Selected Only check box, which allows you to 
select specific objects from the context tree.

Properties

Specific elements in a report that either describe the report (ID, Description, and ModifyDate, 
for example), govern behavior (RowRetrieval property), or specify the format (Chart and Display 
properties). You can modify most properties to customize your report.

You can view the current context and properties settings for a report in the Configuration Card. The 
Configuration Card contains information such as the title of the report, the Database Connection type, 
specific contexts, and the display settings. The contents of the Configuration Card vary according to the 
type of report. You can access the Configuration Card from the Report menu or by right-clicking the 
report.
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Once you have set the contexts and modified properties of a report, you can execute the report and work 
with it in Reporting Center, or deploy it to SSRS. When you modify contexts and properties and execute 
a report, by default Reporting Center caches the data until you execute the report again. When you select 
the report, Reporting Center displays the cached data. To see the more recent data, execute the report 
again. Alternatively, you can configure Reporting Center to cache no data so that executing the report 
displays the most recent data set. You configure the Cached Reports settings on the User Options page of 
the Tools menu.

Whenever you deploy a report to SSRS, you have a number of deployment options, such as executing the 
report on a schedule, and choosing the delivery method of the deployed report. You can configure these 
settings either in the in the Deploy Report window in the Console, or in SSRS.

Setting the Context for a Report
The contexts that Reporting Center displays are determined by the contexts defined in the report. Each 
report can have any number of contexts. This section describes common context controls and explains 
how to display and lock a report context.

Common Context Controls
The following are two common context controls.

Database Connection

Lists the sources of data for your report. You can select a database connection from the list if 
there is more than one connection available for the report.

Time

Allows you to specify the date and time range for a report. You can customize the dates and times 
or choose from predefined ranges. You can also define the interval at which you aggregate data in 
your report. For example, if you have specified a time range of 12 months, you will want to 
aggregate data by month rather than day. You can limit the contents of a report to specific hours 
of the day, and specific days of the week.

Displaying and Locking Report Contexts
In Reporting Center, you access context information from the Context tab in the Tasks pane. When you 
first open Reporting Center, it displays the Tasks pane to the right of the Results pane. When you select a 
report in the Navigation pane, Reporting Center displays the contexts of the report in the Context tab. 
From there, you can view and modify them, and determine which contexts to display. You can remove 
context buttons in Reporting Center to make a long context list more manageable. Reporting Center 
does not remove them from the report.

You can lock a context if you want to override the default context in reports that contain the same 
contexts. For example, you can lock the Date Range context to “Last Month” if you want to execute a 
number of different reports but only display data from the past month for each report. You can also 
execute a report covering the same servers and metrics, but for a number of different time periods.

To lock or unlock a context, click the locking control at the top of the Context tab. When reports do not 
include the same context, Reporting Center automatically unlocks the context for those reports, but 
keeps it locked when you switch to a report that does contain the context.
16 Reporting Guide



To display and manage the context controls of a report:

1. In the Tasks pane, click the Context tab.

2. Click the name of the context at the bottom of the Context pane. You can view one control at a time.

3. If you want to include or exclude specific context buttons from the list, click the arrow at the 
bottom of the Contexts pane and click Add or Remove Buttons.

4. If you want to display or hide contexts buttons, one at a time, click the arrow at the bottom of the 
Contexts pane and click Show More Buttons or Show Fewer Buttons.

5. If you want to lock or unlock a context, click the lock icon at the top of the Context pane.

Setting Report Properties
When you select a report in the Navigation pane, Reporting Center displays the properties of the report 
in the Report Properties tab, which you access from the Tasks pane. The Report Properties tab displays 
the default properties associated with that report, including descriptive information about the report, 
chart settings, display settings, threshold settings, and row retrieval settings. You can configure most 
report properties.

Each time you modify a property in a report, save the report to display the change in the Results pane and 
to save the new setting in the Configuration Card. When you are ready to execute or deploy the report, 
save the report again to ensure that the Console or your browser display the changes correctly.

Displaying Changes to Charts
When you make changes to the chart properties, Reporting Center allows you to apply those changes 
without executing the report each time you make a change. To apply changes to the chart of a report, 
right-click anywhere in the Properties pane and click Refresh Chart. 
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Setting Properties to Enhance Charts
Reporting Center makes it easy to configure the chart properties to create reports that are easy to 
understand. Suppose you are preparing a report that contains data over a period of 20 months. In this 
report, the maximum value for the Y-axis is set to 35. You can use properties to manipulate the way the 
chart represents the data. For example, if you use the default True setting for the Y-axis AutoScale 
property (in the Properties pane, go to AxisY > AutoScale), your chart will look like this:

Reporting Center calculates the maximum value for the Y-axis based on the maximum value in the report. 
Although this chart provides an accurate representation of the values, you can use the AxisY properties to 
provide a more meaningful context in which to present this information. You can set the Y-axis to match 
the possible range of values by making the following changes to the AxisY properties:

• AxisY > AutoScale = False

• AxisY > Minimum = 0

• AxisY > Maximum = 100
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After you modify these values and save the report, the chart will now look like this:

To make the chart even more readable, you can limit the number of labels on the X-axis. For this report, 
for example, it is unnecessary to display a date on each data point for 20 months. You can change the 
frequency of the X-axis labels by using the LabelInterval property (in the Properties pane, go to AxisX > 
LabelInterval).

If you change the X-axis LabelInterval value from 1 to 3, your chart will look like this:

These are just a few of the ways that you can use properties to clarify the information in your charts and 
make them easier to understand. Before you deploy your reports, experiment with the chart properties to 
be sure you are presenting information in the best way for your intended audience. Once you have the 
properties set the way you want, save the report.
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Working with Missing Data Points
Some reports containing trending data display a gap between two points, indicating missing data values. 
Depending on the reason for the missing values, you might want to fill in the gap completely or display a 
dotted line across the gap. For example, if you are monitoring server uptime, and a specific server was 
offline for a period of time, you would want to preserve the gap or display a dotted line across it to 
indicate that there was an interruption to the server uptime. On the other hand, if a specific server was 
offline due to routine maintenance, you could fill in the gap with a solid line to avoid highlighting it.

The two ChartEmptyPoints properties, Appearance and Style, control the way the chart displays the 
missing data points. The Appearance property allows you to specify the way Reporting Center fills the 
gap: by either calculating the average values of all data points, or by using zero as the value for missing 
data points. The Style property allows you to specify the line style that Reporting Center uses to fill in the 
gap: as a solid, dashed, or dotted line. The Style property applies to Line charts only.

The ChartEmptyPoints properties apply to reports that you execute in the Console, not to those that you 
deploy to SSRS.

Exporting Charts and Tables
You can export charts and tables from a report. You save charts in a number of image formats, and save 
tables in text or XML format, as a spreadsheet, or as a Web page.

To export a chart or table:

1. If you want to export a chart, on the chart toolbar, click Export Chart.

2. If you want to export a table, right-click in the table and click Export Table.

3. Type a file name.

4. Select the format in which to save the chart or table

5. Click Save.

Understanding Chart Limitations in Reporting Center
For each report containing a chart, you can override the default chart type and assign a new chart type for 
every column. You do this using by clicking Column in the Properties tab and modifying the LineType 
field in the Column Rules dialog box. Most types work together in the same chart. However, combining 
certain types in one chart will result in unreadable data in the Console. If Reporting Center displays an 
error related to charts, you should restart the Console and execute the report again or choose different 
chart types.

SSRS does not support the LineType and LineColor properties, and will not display them when you 
deploy a report that uses them.

The following table lists chart types (called LineType in the Column Rules dialog box) that you should 
not use in the same chart.

Chart Type Cannot Be Combined With
Area Bar, Pie, and StackedBar.

Bar Any other chart type, except Bar and StackedBar.

Bubble Bar, Pie, and StackedBar.

Column Bar, Pie, and StackedBar.

Line Bar, Pie, and any type of Stacked.
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Using Templates and Dashboard Reports
Report templates and dashboard templates are available in certain NetIQ products. You access templates 
and dashboard reports from the Navigation pane.

Templates

A report template is a pre-defined report that allows you to create a new report based on the 
default contexts. To use a template, you need to save it with a new name and then customize it, if 
necessary.

Dashboard Reports

Dashboard reports provide a way of grouping reports that contain related data in a single layout. 
When you open a dashboard report, Reporting Center displays a thumbnail version of each of its 
member reports. To display the full report, click the title of the member report. You can use any 
dashboard report to create a new one by saving it with a new name and adding or deleting 
reports. If you change and redeploy a report that is also in a dashboard, you need to redeploy the 
dashboard report as well.

Executing and Deploying Reports
You cannot deploy a report that does not execute properly, for example, due to an invalid context setting.

In order to deploy a report with the current properties, save the report before you deploy it. If you do not 
save the report with the current properties, it will be deployed with whatever properties were last saved.

After you have executed a report, you can then deploy the report to SSRS. From SSRS, you can schedule 
the report to execute periodically. You can configure SSRS to send the report by email to one or more 
users, or write the report to a file share. You can also view the report by using a Web browser with access 
to SSRS.

From the Console, if you delete reports that are already deployed, then Reporting Services may not 
display such reports correctly. To deploy reports to Reporting Services, you must have permission to 
deploy a report from the Console and have Administrator level permissions on the Reporting Services 
computer.

Pie Cannot be combined with any other chart type. It can only be used to 
represent a single series of data.

Point Bar, Pie, and StackedBar.

Spline Bar, Pie, and StackedBar.

SplineArea Bar, Pie, and StackedBar.

StackedArea Bar, Pie, and StackedBar.

StackedBar Any other chart type, except Bar and StackedBar.

StackedColumn Bar, Pie, and StackedBar.

StepLine Bar, Pie, and StackedBar.

Chart Type Cannot Be Combined With
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SSRS Considerations
Before you deploy reports to SSRS, consider the following information:

• Reporting Center allows you to configure SSRS from the Console, without opening SSRS. You can 
schedule the report to deploy at intervals, choose the delivery method for the report, and indicate 
who receives the report.

• Once you have deployed a report to SSRS, you manage that report from the SSRS interface. For more 
information about SSRS, see the Microsoft documentation, Reporting Services Books Online, which is 
part of the default installation of SSRS.

• Users who deploy reports to SSRS must have permission to deploy a report from Reporting Center 
and also have Administrator-level permissions on the computer running SSRS.

• When you execute a report, the Reporting Center Console does not display empty columns in the 
chart. When you deploy the report, SSRS includes those empty columns in the report so that they 
can be displayed when data is available for those columns.

• SSRS does not support all the chart properties that Reporting Center allows you to implement. 
When you deploy a report with any of those properties, Reporting Center displays a warning that 
SSRS does not support the specific property and gives you the option not to deploy the report. If you 
do continue to deploy the report, SSRS will either substitute a chart property or leave the property 
out of the SSRS report.

Executing a Report
Once you have configured your report and modified any contexts and properties, you can execute it and 
view the latest report. Before you execute a report, you should save it from the toolbar or menu. Then you 
can execute it using the Execute Report button in the toolbar or the link in the Tasks pane. Reporting 
Center displays the report in the Results pane. You can then deploy it to SSRS.

Deploying a Report to SSRS
After you have saved and executed a report, you can deploy it to SSRS. From the Console, you can 
configure SSRS to schedule the report to execute periodically, send the report by email to one or more 
users, or write the report to a file share. You can view the report by using a Web browser with access to 
SSRS.

In order to deploy reports to SSRS, you need permission to deploy a report from Reporting Center, and 
Administrator-level permissions on the computer running SSRS.

In the Reporting Center, if you delete reports that you have already deployed, then SSRS might not 
display them correctly.

To deploy a report to SSRS:

1. Select the report and then click Deploy Report on the toolbar.

2. Type information in the Deploy Report dialog. For more information about this dialog box, see the 
Help. You can also accept the default information about the Report Server location and credentials.

3. Click Deploy Report.

4. You can view the deployed report by going to the SSRS home page and typing the following URL: 

http://<SRS Server Name>/Reports

5. Click the report you deployed.
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Working with Deployed Reports
For reports that allow you to specify a time range, you can modify the time range of the deployed report in 
SSRS without returning to the Console to redeploy the report. This ability to change the time range in 
SSRS provides a user who does not have the Console installed with the flexibility to view data from a time 
range other than the one specified at the time you deployed the report.

For example, if you deploy a report that displays data from the last seven days and deliver it to a manager 
who wants to see the last 30 days, the manager can change the start and end dates in the SSRS user 
interface to view data from the last month.

For these types of reports, you use the Deploy Report window in the Console to specify that users can 
modify the time range of the data SSRS displays.

To enable date range customization in SSRS:

1. From the tree in the Navigation pane in the Reporting Center Console, select a report that contains 
a Time context.

2. Click Deploy Report from the toolbar, and in the Deploy Report window, select the Allow user to 
modify start and end date check box.

3. Click Deploy, and open the report in SSRS to confirm that it contains Start Date and End Date 
controls.

When you modify the date range in SSRS and redeploy the report, the deployed report displays the new 
date range. When you navigate away from the report and then return to it, SSRS displays data in the date 
range that you set when you deployed it from the Console, not the range you specified in SSRS.

The ability to change the time range in SSRS is available only for standard reports that contain a Time 
context only. It is not available for dashboard reports.
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Appendix A
Troubleshooting

This appendix includes suggestions for resolving issues you may encounter when using Reporting Center.

General Web Service and Logon Issues
If you encounter errors when you log on to the Console or when you try to connect to the Reporting 
Center Web Service for another reason, check that there has been no change to the SQL account 
credentials. If the Web Service is installed on IIS 7.0 or later, check that ASP.NET Impersonation 
authentication is disabled in the ACWebService Virtual Directory.

You can also configure IIS to display more detailed error messages in order to diagnose the problem.

The following sections describe how to perform these tasks.

Resetting the SQL Account
If the Reporting Center Web Service is installed using a SQL account, and the password on that account 
is subsequently changed, you will see the following message:

Login Error: Login failed for user <SQL User Account> using the SQL account.

To resolve this issue, uninstall the Web Service and reinstall it using the new SQL password. This will not 
affect your reports.

Verifying the Authentication Settings
For IIS 7.0 or later, in the ACWebService Virtual Directory, Windows Authentication is enabled and 
ASP.NET Impersonation Authentication is disabled by default. If the Virtual Directory is no longer 
configured this way, you will be unable to log on to the Web Service.

To configure authentication settings in IIS 7.0 or later:

1. Start IIS Manager on the computer where you installed the Web Service, and expand the Web Sites 
folder.

2. Expand the Web Site where you installed the Web Service, and click ACWebService.

3. In the IIS section of the center pane, double-click Authentication.

4. If ASP.NET Impersonation is enabled, select it and click Actions > Disable.

5. If Windows Authentication is disabled, select it and click Actions > Enable.

6. Close IIS Manager.
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Configuring Error Messages
If IIS Manager is displaying generic error messages, you can configure Internet Explorer to display more 
technical error messages in order to obtain more information.

To configure error messages in Internet Explorer:

1. Click Tools > Internet Options.

2. Click the Advanced tab and clear the Show Friendly HTTP Error Messages check box in the 
Browsing list. You might need to scroll down to view it.

3. Go back to IIS Manager and generate the Default Web Site error or Web Service error again to obtain 
more detailed information.

4. Contact NetIQ Technical Support with this information.

Reporting Center Web Service Unavailable
If you log on to the Console and the Reporting Center Web Service is unavailable, you will see the 
following message:

Login Error: The request failed with HTTP status 503: Service Unavailable.

Verifying That the Application Pool is Running
If you encounter this error message when you log on, ensure that the Reporting Center NRCAppPool 
application pool is installed and running. If it is not, you should restart it in IIS Manager and log on to 
the Reporting Center Console again.

To manually start the NRCAppPool application:

1. Start IIS Manager on the server hosting the Reporting Center Web Service, and expand Application 
Pools.

2. Right-click NRCAppPool and select Start.

3. Close IIS Manager and log on to the Reporting Center Console.

Resetting an Expired Windows Account
You can also check whether the Windows account used to install the Web Service has expired. If it did 
expire, and Reporting Center displays the Service Unavailable error when you log on, reactivate the 
account and reset the password. Then reset the Reporting Center Application Pool (NRCAppPool) 
identity. The NRCAppPool Identity user is the Windows account that was used to install the Reporting 
Center Web Service.

To manually reset the NRCAppPool identity user password:

1. Start IIS Manager on the server hosting the Reporting Center Web Service, and expand Application 
Pools.

2. If you are running IIS 6.0:

a. Right-click NRCAppPool and select Properties. Click the Identity tab.

b. Click Configurable, enter the Identity user credentials, and click OK.

c. Right-click NRCAppPool and select Start.
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3. If you are running IIS 7.0 or 7.5:

a. Select NRCAppPool.

b. From the Action pane to the right of the Application Pools list, click Advance Settings.

c. In the Process Model section, select Identity and click Custom account.

d. Click Set, and enter the Identity user credentials in the Set Credentials window.

e. Click OK to close the Set Credentials window, the Application Pool Identity window, and the 
Advanced Settings window.

f. Right-click NRCAppPool and select Start.

No Data Found In a Report
If you execute a report and Reporting Center displays a “No Data” message, you can try one of the 
following solutions.

Verifying the Privileges
Check that the you are running Reporting Center with the correct privileges by copying the Web Service 
URL into a browser. The browser should display the NetIQ Reporting Center Web Service Diagnostics 
page without prompting you for any credentials.

If you are prompted for credentials, then IIS is not authenticating your account automatically, as it 
should. Ensure that the System Administrator set up the account on IIS with the correct privileges.

Verifying Previous Data in the Report
If your privileges and connections are configured correctly, then the report might not contain data for the 
contexts specified for the report. In this case, you should check whether Reporting Center can retrieve 
data for a broader range of contexts, such as a greater time or date range.

To verify if the data is outside the current context configuration:

1. In the Context Pane of the Console, change the relevant contexts to include a broader date range or 
more information (such as selecting all items in a navigation tree).

2. Click Execute.

If the report contains data, Reporting Center displays the information according to the contexts you 
reconfigured. This indicates that Reporting Center had originally executed the report correctly, but 
had no data to retrieve for the specified contexts.

Web Site Host Header Value Error
If your Web site is configured with host header values, which allow you to map multiple Web sites to an 
IP address, ensure that the Web site is configured to accept requests based on host header names. For 
more information, see the following Microsoft Knowledge Base article:

http://support.microsoft.com/kb/308163
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